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New in Version 10 
 
 
A summary statistics module (SumStats) includes 31 procedures for analyzing counts, 
proportions, and means.  
 
The procedures are listed below: 

 
§ Weighted Mean 

§ Z-Score 

§ Confidence Intervals (Mean/Proportion) 

§ Goodness of Fit 

§ Chi-Square Test of Independence (6x6 table) 

§ Z-Test of Proportions (One/Two Sample) 

§ T-Test of Means (One/Two Sample) 

§ One-Way ANOVA (6 group means) 

§ Z, T, F, Chi-Sq Distributions (estimates p-value) 

§ Diagnostic Accuracy (2x2 table) 

§ Epi Curve.  Creates an Epidemic Curve chart from a timeline with disease onset 

counts that can be saved or printed. 

§ Epidemiology Rates and Risk statistics. 

§ Epidemiology Direct Standardization of Rates 

§ Disaggregate Counts.  Creates a data file from summary statistics for the charts 

procedure.   

§ Decision Tools (constant dollars, queuing theory, price elasticity, decision tables) 
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Introduction 
 
 
AcaStat provides students, teachers, researchers, and managers with an inexpensive and easy 
to use data analysis tool and instructional aid.  AcaStat includes a spreadsheet for entering and 
viewing data, an Explore module with statistical procedures, an Output Log, and a Summary 
Statistics module.  A statistics glossary is also provided along with example data. 
 
 

Getting Help 
 
Application help can be found in this manual and in the Help module provided with AcaStat.  
An annotated Overview and How To Guide for using statistical procedures are available in the 
Help module or at http://www.acastat.com/support/support.html.  
 
In addition to application help, statistical help is provided in three formats:   
 

• Stat Guide that provides annotated output examples for many of the statistical 
procedures. 

• Glossary of statistical terms and definitions. 
• Student Workbook in pdf format. 

 
 

Installation 
 
Download an evaluation version or purchase AcaStat from http://www.acastat.com or the Mac 
App Store.  The software is downloaded in a self-extracting file.  Save the software and 
double-click on the file to begin the installation process. 
 
 

Uninstalling AcaStat 
 
For Mac versions, drag the program file to the Trash Bin.  For Windows versions, use the 
Windows Control Panel option ADD/REMOVE programs to uninstall AcaStat.  Files that were 
created or changed after installation of AcaStat must be removed separately by the manual file 
deletion procedures in Mac and Windows.   
 
 

Terminology Used in the Manual 
 
When discussing statistical procedures, the manual will refer to two general types of data --
continuous and categorical.  The following terms will be used for convenience and simplicity, 
but there are variations in these themes that will be apparent to those with statistics training.  
Please see the Statistics Glossary in AcaStat for more information on these and related terms. 
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Continuous Data – This refers to data where it is reasonable to calculate an average.  This type 
of data is also referred to in statistics as interval/ratio level of measurement or scale data. 
 
Categorical Data – This refers to data where averages would not be meaningful.  This type of 
data is also referred to in statistics as nominal/ordinal level of measurement or discrete data. 
 
 

AcaStat Startup Screen 
 
 
AcaStat starts by displaying the Explore tab.  Use the Explore tab to select and run analyses.  
A control panel along the left side of the application contains statistical procedure controls and 
a list of variables when a data file has been loaded.  The Data tab displays a spreadsheet that 
can be used to create or view a data file.  The Output Log module automatically displays the 
results for the current analysis and stores all analyses conducted after opening AcaStat.  The 
output from all procedures is automatically appended to the Output Log.  The SumStats tab 
provides 31 summary statistics procedures for counts, proportions, and means.  The Tables 
tab creates summary tables with row and column variables. 
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Explore 
 
 
The Explore tab contains the statistical procedure options along with a list of variables from the 
Data tab.  An option box is displayed along with analysis variable list boxes and a control 
function.  Drag and drop variables into the analysis list boxes and then click the Calculate 
toolbar button to the run the procedure.  For most procedures, a subset of key summary 
statistics is presented in the Analysis Dashboard for quick review and comparison.  Additional 
summary statistics are added to the Output Log.  
 

 
 
Copying and Printing from the Analysis Dashboard 
 
The summary statistics displayed in the Analysis Dashboard are temporary and will be lost if 
AcaStat is closed or the New button is pressed.  Although the Dashboard output cannot be 
saved, the complete summary statistics produced by each procedure can be saved from the 
Output Log tab.  
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Dashboard output can be printed by clicking the Print toolbar button.  The printing format will 
be consistent with the Dashboard display and in most cases is formatted differently than what 
is recorded in the Output Log.  Dashboard output can also be copied and pasted into a 
spreadsheet or word processor.  To copy all of the visible output, click the copy button without 
selecting any rows.  To copy only a portion of the output, use the mouse to select the rows for 
copying.  Pasting the output into a spreadsheet will separate the output into columns so the 
general presentation is not altered.  The spreadsheet column widths may need to be adjusted 
to display the data properly. 
 
Right click on the Explore output listbox to change the print font. 
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Explore Charts 
 
The display of an Explore chart will depend on the statistical procedure selected.   Below is a 
summary of the available charts depending on the statistical procedure selected. 
 
 
Summary of Explore Output and Chart Features 
 

Procedure 
Explore 

Output Charts 
Frequencies Current analysis only Horizontal bar chart * 

List Variables List of up to ten variables None 

Descriptives List of all analyses Histogram** 

Explore Means List of all analyses None 

Crosstabulation List of all analyses None 

T-Test of Means List of all analyses None 

Paired T-Test List of all analyses None 

Wilcoxon Signed-Rank List of all analyses None 

Mann-Whitney U List of all analyses None 

ANOVA List of all analyses None 

Kruskal-Wallis List of all analyses None 

Correlation List of all analyses Scattergram** 

Spearman rho List of all analyses None 

Point-Biserial List of all analyses None 

OLS Regression List of all analyses Histogram of residuals** 

Logistic Regression List of all analyses None 

Diagnostic Tests Current analysis only ROC curve  

Sample Random None None 

Sample Repeated List of all analyses Histogram of means** 

Appraisal Ratios List of all analyses None 
 
*    Frequencies displays a horizontal bar chart for the last variable selected. 
**  To view a prior chart, select the row containing the summary statistics. 
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Chart Print Preview 
 
Click on the chart to open a preview screen with chart options. The preview screen allows the 
user to edit the titles (click on a title to edit) and change the color of the data points in the 
chart.  Scattergram and line charts also provide an option to display the numerical values in the 
graph.  All charts can be printed, saved, or copied for pasting into other software.  To increase 
the size of the chart, resize the preview form to the desired size.  
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Data Module 
 
 
The Data tab uses a spreadsheet to create, import, and export data files.  Opening or importing 
a new file will replace the current contents.   
 

 
 
Spreadsheet Edit Limitations 
 
The data spreadsheet is designed for creating, viewing and editing individual cell contents.  
Copying and pasting of individual rows or columns is not allowed to avoid potential corruption 
of the underlying data array.   
 
Deletion of rows and columns 
 
Deletion of observations (rows) and variables (columns) are allowed.  Individual or multiple rows 
can be selected for deletion.  Columns of data must be selected and deleted individually (only 
one column per delete operation).  
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Copy Data 
 
The copy operation in the Data tab will copy all data array contents (the entire data file).  When 
using paste, all spreadsheet contents are replaced with the data saved in the system clipboard, 
thus creating a new data file.   
 
It is important to note that to prevent corruption of the underlying data array, the spreadsheet 
prevents copying and pasting selected rows and columns of data.  If users wish to do 
significant copy and paste operations, it is recommended that this be conducted in a third 
party spreadsheet product before importing into AcaStat.  Although these options are standard 
in most spreadsheets, such procedures in AcaStat may inadvertently replace existing data or in 
large data files result in significant delays in reorganizing the underlying data array that is used 
for the statistical procedures.  
 
Observation (row) Duplication 
 
Copying of rows of data is prohibited in AcaStat. 
 
Variable (column) Duplication 
 
Columns of data (variables) can be duplicated using the Recode/Compute module.  This will 
duplicate selected variables into new variables that are appended to the end of the variable list. 
Each duplicated variable will require manual formatting of variable and value labels.  Formatting 
can be copied from the original variables and pasted into the duplicated variables using the 
Data tab format module. 
 
 
Rows 
 
Each row represents one observation (this is also known as the unit of analysis).  If the data 
contain information on individuals, each row should contain the data for one person 
(observation).  If the data contain information on cities, each row should contain the data 
relevant to one particular city. 
 
 
Columns 
 
Each column represents data for all observations relating to one variable or characteristic.  As 
an example, if a column contains information on personal income in U.S. dollars, all data in that 
column should represent the income for each person in the data file.  For data files with more 
than 60 columns, the spreadsheet can be advanced to the next 60 columns by clicking the 
forward arrow button. 
 
 
Cells 
 
Each cell represents a value for one observation for one variable.  It can contain string data 
(words) or numerical data (numbers).  Most research data files use numerical data to represent 
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words.  As an example, for the variable sex, it is common to code Male as "0" and Female as 
"1.”  This makes data entry much easier since one number is entered instead of typing a word. 
It also simplifies recoding variables, identifying controls, and running analyses. 
 
 
Entering data 
 
To enter data, select a cell and begin typing.  Pressing an arrow key will save the entry and 
move the data entry point to another cell.  As an example, pressing the right arrow key will 
save the entry and move the data entry point to the right.  Pressing the Escape (Esc) key will 
cancel data entry.  Pressing the Enter key will move the data entry point down one row. 
 
 
Editing data 
 
To edit data, click on the cell to edit. Pressing any of the arrow keys will save the entry and 
move the data entry point to an adjacent cell.  Do not enter special characters such as $, %, or 
comma (unless used as the locale decimal indicator) and avoid the use of strings (words) 
whenever possible. 
 
 
Spreadsheet and Data File Limits 
 
The spreadsheet will display up to 60 columns of data at one time.  For data files with more 
than 60 variables (columns), the spreadsheet can be advanced to the next 60 columns by 
clicking the forward arrow button.  The number of rows is controlled by system memory and 
speed of the computer.  Files larger than 100,000 observations will slow loading and analysis. 
 
Slowness related to large files can be improved by using the Split Data or Change Spreadsheet 
Maximum options.  Both are found in the Data pull-down menu.   
 
The Split Data procedure will create a new file with fewer variables.  The new file will have the 
same number of observations and formatting as the original larger file.  Additional variables can 
be added from the master file using the Merge Data Files-Add Variables option in the Data pull-
down menu.  If a file has a large number of observations, the random sample statistical 
procedure can be used to create a more manageable data file. 
 
The Change Spreadsheet Maximum procedure can be used to temporarily reduce the number 
of rows shown in the spreadsheet. The default spreadsheet maximum is set to display up to 
500,000 rows of a data file.  Reducing the display of very large data files will improve analysis 
speed and functionality.  The optimal display setting is the minimum (50 rows).  All 
observations remain in system memory for analysis.  Files that contain more than 10,000 
observations or more than 100 variables will benefit most by reducing the spreadsheet row 
maximum. 
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Lockable Row Identifier 
 
By default, AcaStat numbers each row in a column labeled “Obs”.  This simplifies verifying 
data for individual records by displaying and freezing a copy of the identifier variable to the left 
of the data.  If a data file has its own variable (column) with a unique row identifier, select any 
cell in this column and click the “+” button at the bottom of the Obs column to display a copy 
of the identifier variable to the left of the data.  Reset to Obs by clicking the “-“ button.   
 
 
Drag and Drop 
 
The data spreadsheet accepts drag and drop for AcaStat data files and delimited text data files 
(tab and csv).  The Output Log tab accepts drag and drop for AcaStat output text files. 
 
 
Formatting Variables 
 
Use the screen displayed to the right of the spreadsheet to format variables.  Click a column in 
the spreadsheet to view and edit the variable’s formatting. In order to produce output that is 
easier to interpret, create variable names and assign short explanatory labels to variable names 
and values.  Formatting information will be saved with the AcaStat data file and can be 
changed at any time. If data are exported, the formatting information will not be exported.  
Click the Copy Format button to copy value and missing settings for pasting into other 
variables with the same format, such as survey questions with identical response options.  
Click a cell in the data spreadsheet or the “Set” button to record changes to formatting.  The 
data file must be saved as an AcaStat data file to retain formatting changes. 
 
 
Variable Name 
 
Since variable names are used as column labels and are listed in the variable list boxes, it is 
important to create short but unique variable names (8 characters or less is recommended).  As 
an example, level of education could be named DEGREE or EDUC or EDYRS.  
 
 
Variable Label 
 
Use variable labels to create a more detailed description of the variable.  The variable label is 
used to create more meaningful output. Using the above example, DEGREE could be labeled 
"Respondent Highest Degree."  Although variable labels can be longer, the Explore output 
display works best with variable labels that are 30 characters or less 
 
 
Change Decimals 
 
Reduce the number of decimals displayed (and stored) for the selected variable.  This option 
will permanently reduce the decimals displayed in a variable when the file is saved. 
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Value Labels 
 
Use value labels to create a more detailed description of the values used in a categorical 
variable.  The value label is used to create more meaningful output.  If education is coded 0 
through 4 to represent five general categories, the values would be more meaningful if labeled 
0="< High School", 1="High school", 2="Junior college", 3="Bachelor", 4="Graduate".  
Without labels, the output will show the values 0 through 4.  Limited to 12 value labels. 
 
 
Missing Values 
 
Identify up to four numerical or string values to be excluded from the statistical analysis (blank 
cells are always considered missing).  Values that are less than (<) or greater than (>) a set 
value can also be set as missing.   
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Menu System 
 
 

File Menu  
 
New 
 
Clears all data from the spreadsheet and resets the variable 
lists. 
 
 
Open Data File 
 
Use to open an existing AcaStat data file.  AcaStat data files 
have the extension ".dcs”.  AcaStat files contain data 
formatting, coding of missing values, and data file notes. 
 
 
Save Data File As 
 
Saves the contents and any formatting of the data into an AcaStat data file. 
 
 
Data File Information 
 
Displays file information and also has a section for file 
notes.  Changes to the file notes will not be retained until 
the data file is saved. 
 
 
Import Tab Delimited Data 
 
Opens a text file that contains tabs between each variable 
so AcaStat is able to import the data into a spreadsheet 
format.  These files normally have a filename extension of 
".txt” or ".dat”. 
 
 
Import Comma Delimited Data 
 
Opens a text file that contains commas between each 
variable so AcaStat is able to import the data into a spreadsheet format.  These files normally 
have a filename extension of ".csv” (comma separated values).  Countries that use comma 
decimal delimiters should use tab delimited instead of csv to import or export data. 
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Import Other Delimited Text Data 
 
If uncertain about how the file is delimited, use this option to view the file and identify the 
correct delimited character.  The correct delimited value will separate the data into columns.   
 
 
Tips on Importing Data 
 
Import data from text data files or by pasting data copied from a word processor, spreadsheet, 
or database table.  Please see the section below on using a spreadsheet application to create 
compatible data files. 
 
 
Tips on using a spreadsheet application to create a csv or txt file 
 
The first row in the spreadsheet should contain a unique variable name that represents the 
data in that column (try to keep the names 8 characters or less).  The variable names identify 
columns when imported into the AcaStat spreadsheet and are used to select columns of data 
for analysis.  To save a delimited text file, use File/Save As and select the file type as either tab 
delimited or comma separated values (CSV) format. 
 

 
 
Pasting Data 
 
To paste data from a table, select and copy data in a word processor, spreadsheet, or 
database table.  In the Data tab, select "File/Import/Paste Data" or use the paste button on the 
toolbar.  The paste procedure replaces all data in the current spreadsheet.  Copied data must 
be consistent with the tips discussed above. 
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Apple Numbers 
 
Copy and paste Numbers tables or use drag and drop of the data table into the AcaStat data 
spreadsheet.  Another option is to export and import as a CSV file. 
 
When exporting data in Numbers use the following format so the first row and column of data 
are in the grey area and the variable names are in the grey row as depicted below: 
 

 
 
Recommended parameters for exporting a spreadsheet for AcaStat import. 
 

 
 
 
Importing Text Data Files 
 
AcaStat assumes the first row in an imported file contains the variable names.  If the data file is 
large, it may take a few moments to read the data.  Once read, the data will be displayed in the 
spreadsheet and variable names (column headings) will be visible in the variable list box.  After 
importing data, save the file as an AcaStat system file.  This will decrease the time it takes to 
load a file and allows the file to retain variable formatting.  As noted earlier, use the Split Data 
module to reduce the size of very large data files (it is not unusual to see social science data 
files with over 800 variables).  Additional variables can be added from the master file using the 
Merge Data Files-Add Variables option in the Data pull-down menu. 
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Example of Import Error 
 
When creating a comma separated value file, make sure all commas have been removed from 
the cell contents before creating the file.  If they are not removed, as might be the case with 
currency data, AcaStat’s import procedure will create an extra variable for each comma. This 
will cause the cell contents in the AcaStat spreadsheet to be out of alignment with the column.  
In the example below, the data in rows two and three do not align properly with the appropriate 
columns. 
 
 

 AGE SEX INCOME V4 
1  65  M  33000  
2   23  M  
3  46000  45  F  

 
 
Other import errors may occur if the text file does not exactly match the format specified 
above.  The following list is not complete, but it contains common errors in importing data. 
 

• No variable names in the first row 
• Blank rows at the top of the data file 
• Special embedded characters in the cells that are neither numbers nor words.  This is 

especially common in data copied from an html table from the Internet. 
• Embedded tabs in spreadsheet cells 

 
 
Export Data (Tab Delimited) 
 
Use Export Data to save the contents of the spreadsheet as a text file that contains tabs 
between each variable (column).  These files are given the filename extension ".txt”.  This file 
can be viewed and edited in word processing or spreadsheet software and can be imported 
into other statistical software. 
 
 
Export Data (Comma Delimited) 
 
Use Export Data to save the contents of the spreadsheet as a text file that contains commas 
between each variable (column).  These files are given the filename extension ".csv”.  This file 
can be viewed and edited in word processing or spreadsheet software and can be imported 
into other statistical software. 
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Edit Menu  
 
 
Cut 
 
When the Output Log tab is selected, this cuts the selected text 
from the output screen. 
 
 
Copy 
 
When the Explore module is visible, this option will copy the entire output table or only the 
selected rows. If the Data module is visible, this operation copies the entire data file for pasting 
into a spreadsheet or other software.  Copying data does not copy the variable formatting.  If 
the Output Log tab is selected, this copies the selected text in the output screen. 
 
 
Paste 
 
When paste is used in the Data module, an import procedure places data copied from another 
application into the spreadsheet.  Paste clears the spreadsheet before importing the data.  The 
operation is identical to importing a tab delimited data file.  If the Output Log tab is selected, 
this pastes the text into the output screen. 
 
 
Select All 
 
When the Output Log tab is selected, this selects all the text in the output screen. 
 
 
Change Font Style 
 
When the Explore or Output Log tab is selected, this allows temporary changing of the text font 
style.   This change affects viewing and printing.  The font style reverts to the default upon 
exiting AcaStat. 
 
 
Convert Output to Tab Delimited 
 
When the Output Log tab is selected, this formats the output with tabs to improve the 
alignment of tables copied from AcaStat for pasting into spreadsheet software.  The tabs are 
used by spreadsheet software to align the table data properly into columns.  After copying and 
pasting into a spreadsheet, some editing and formatting may be necessary.   
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View Menu  
 
The View menu provides shortcuts to the AcaStat modules.  It 
also provides a link to Calculator module. 
 
 
View Calculator 
 
Open the calculator module via the View menu. The Calculator 
module includes a Calculator Log that stores a record of 
calculations.  The Calculator Log can be exported to the AcaStat 
Output tab for saving, editing, and printing. 
 
To add notes to the Calculator Log, click the Edit button and enter notes. Moving cursor from 
the Calculator Log will lock editing. 
 
Most of the operations are self-explanatory.  The one function that may not be commonly 
available in a calculator is the button allowing the change of a sign. To change the sign, enter a 
value and click the change sign button to change a positive value to negative or negative to 
positive. 
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Data Menu 
 
 
Add 50 Rows 
 
Adds 50 rows to the bottom of the spreadsheet. 
 
 
Delete Row 
 
Deletes the row for the currently selected cell.  
Delete one row or multiple selected rows.  The 
change will be complete when the data file is 
saved. 
 
 
Delete Column 
 
Deletes the column for the currently selected cell.  Delete one column at a time.  The change 
will be complete when the data file is saved. 
 
 
Convert Data to Locale Decimal Format 
 
Change decimal formatting to match the locale decimal indicator (this procedure only applies to 
comma and period decimal indicators).  Analyses will be incorrect if the data file uses “.“ as the 
decimal indicator when the locale decimal for numeric data uses “,“ as the decimal mark. 
 
This operation will not work properly if thousands indicators (periods or commas) are used in the 
data.  Remove any thousands indicators before running the conversion.  As a general data entry 
practice, avoid using any special characters or thousands indicators when entering numerical 
data.  As an example, enter $10,000.95 as 10000.95. 
 
After the conversion, save the data using a different file name. 
 
 
Change Spreadsheet Row Maximum 
 
Temporarily reduce the number of rows shown in the spreadsheet. The default spreadsheet 
maximum is set to display up to 500,000 rows of a data file.  Reducing the display of very large 
data files will improve analysis speed and functionality.  The optimal display setting is the 
minimum (50 rows).  All observations remain in system memory for analysis. Files that contain 
more than 10,000 observations or more than 100 variables may benefit most by reducing the 
spreadsheet row maximum. 
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Copy Data from Spreadsheet 
 
Copies all the data in the spreadsheet for pasting into other software. 
 
 
Paste Data into Spreadsheet 
 
Paste data copied from a word processor, spreadsheet, or database table.  The data must 
have variable names on the first row of the copied data.  To paste data from a table, select and 
copy data in a word processor, spreadsheet, or database table.  In the data spreadsheet, 
select Data/Paste Data Into Spreadsheet.  A data module will display a portion of the data for 
review before importing.  This procedure replaces all data in the current spreadsheet.  
 
 
Split Large Data Files 
 
Use Split Large Data Files to create a new data 
file that contains a subset of variables from the 
current file.  This feature reduces the size of large 
data files to increase analysis speed and improve 
data editing capacity.  The new file retains 
variable formatting.   
 
Click the Edit pull-down menu in the Data module 
and select the Split Large Data Files option.  A list 
of the variables in the current data file is 
provided.  Select variables from the current file 
list to include in the new file and click the right 
arrow button or use drag and drop.  To remove a 
variable from the new file list, select the variable and click the left arrow button.  Click run to 
create the new data file. 
 
 
Merge Data Files - Add records from another file 
 
This procedure merges two AcaStat data files with matching variable names so that the 
observations in one file are added to the observations of another AcaStat data file.  The order of 
the variables in the matched data files do not have to be identical and the matching of variables 
is case insensitive (treats capitalized and non-capitalized letters the same).  This procedure is 
especially useful if the same data formatting (variable names, labels, value labels, missing values) 
is used to collect new data.  Examples include repeated surveys or monthly data downloads 
from a website or bank account. 
 
Use the following process: 
 
Create and save an AcaStat data file with all the formatting set for variable and value labels and 
missing values. 
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Create additional AcaStat data files by entering the data or importing a delimited data file and 
then saving as an AcaStat data file.   
 
To merge files, 
 

1. Open the file that has the formatting 
2. Use the menu item [Data/Merge Data Files-Add Records…] to select and open the 

second file. 
 
The observations from the second file will be added to the first file.  Save this file as an AcaStat 
data file and repeat after each file is added.  Cells in columns without matching records will be 
blank (empty). 
 
 
Merge Data Files - Add variables from another file 
 
This procedure adds variables with unique matching record (row) identifiers to link observations 
and add variables from another file.  The number of rows remains the same but the number of 
columns in a data file is increased to add the additional variables.  This supports adding variables 
from other data collection efforts on the same subjects such as pre- and post-test comparisons 
or cohort studies or adding additional variables from a parent file to a file created with the Split 
Data function.   
 
Use the following process: 
 
Verify both files have matching identifying (ID) variables (the ID variable name in both files must 
be identical) and the values are unique for each row (no ID number in one data file can be used 
more than once).  The ID variable is commonly found with variable names such as “ID,” “IDNUM,” 
or CaseID.  
 
To merge files, 
 

1. Open one AcaStat data file 
2. Use the menu item [Data/Merge Data Files- Add variables…] to select the ID variable 
3. Click Set to open the second file. 

 
All of the variables from the second file will be added to the first file.  If adding variables from a 
master file, use the Split Data option first to create a more defined merge file.  Save the merged 
file as an AcaStat data file.  Cells in rows without matching ID records will be blank (empty). 
 
 
Create Data Dictionary 
 
This option creates an Output Log item that lists the data file variables, variable and value 
labels, and missing values formatting.  The data dictionary is displayed in the Output Log for 
saving or printing. 
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View Data Dictionary 
 
Hides or displays the format screen.   
 
 
Hide Data Format Panel 
 
Hides or displays the data format module.   
 
 
Set Weight Variable 
 
Select Use Weight Variable to identify a variable for weighting observations.  Weights are used 
to compensate for over or under sampling to produce more representative population values 
from a random sample.  Weights can be used in the frequency and descriptive procedures.  
Weights will not be applied to any other procedures.  Only one weight can be selected at a 
time. 
 
 
Filter Data  
 
Select Filter Data to exclude observations from the analysis.  Use up to two variables to exclude 
observations.  The rows excluded from the analyses are marked by a bolded X.  Resetting the 
filter removes the filter from future analyses.  No data are permanently lost when using a filter.  A 
filter variable will be added to the spreadsheet.  If the data file is saved after filtering, this filter 
variable can be used later as a control.  
 

 
 
Note: 
 
Saving data when the Filter is enabled will only save the unfiltered data.  This option can be used 
to reduce the size of large files to a subset data file that is easier to analyze, view, and edit.  To 
save the entire file, reset the filter before saving. 
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Recode Menu  
 
 
Recode Values 
 
Use the values of one variable to create a new variable.  This is 
most useful when there are several categories in a variable that 
can be combined into fewer meaningful groups.  As an example, 
recoding years of education into less than high school, high 
school, some college, and college graduate. 
 

 
 
Procedure 
 
ü Select the variable(s) to recode by clicking on the variable name in the list box.  
ü Select the operation to perform by clicking on a radio button.  For coding less than 12 

years of education, select the "<" button.  
ü Enter the value to use as the basis for the recode.  For the above example, enter 12.  
ü Enter a variable name for the new variable (limit to 8 characters).  Example "EduCat" for 

education.  
ü Enter the new variable's value to represent the old values.  For this example, use 1 to 

represent anyone with less than 12 years of education.  
ü Click the Recode button.  
 
A new column will be added to the spreadsheet that has the new variable name and the 
recoded value.  Repeat the process until all values needed for the new variable have been 
recoded.  A module is also available to conduct multiple recodes in a single operation (up 100).  
Click “Set Multiple Category Ranges,” select a variable, provide a name for the new variable, 
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and then enter start and end values for each category range.  The module automatically 
provides default values for the recodes but the values can be edited.  Only use numerical data. 
 
More than one variable can be recoded at the same time.  Select and recode multiple variables 
by holding the Control button [Mac Command button] while selecting variables in the list box.  
Leave the variable name blank.  AcaStat will automatically name each new variable using the 
original variable name and adding "-2" to the name.  This option should only be used if the 
variables have the same range of potential values (e.g.; 1 to 10; 1,2,3,4; etc.). 
 
 
Recode Strings 
 
Create a new variable that recodes strings into 1 to 12 numerical categories.  Recoding strings 
into values greatly simplifies analysis, control, and recode operations.  Use the same recode 
value to combine multiple string categories into one meaningful category.  Category values 
must be between 1 and 12.  Enter a value label for each category.  The module will display a 
list of strings in alphabetical order with category counts to help you decide which categories 
are most frequently used.  Categories not coded will be treated as missing or use 0 to 
represent 'Missing' categories (recommended approach).  
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Procedure 
 
ü Open the Strings tab in the Recode module and select the variable you wish to change in 

the list box.  
ü Enter the values (1 to 12) to recode each string into a value.  
ü Enter a helpful value label.  
ü Enter a variable name for the new variable you are creating (limited to 8 characters).  
ü Enter a variable label for the new variable. 
ü Enter 0 for those strings you wish to make missing - do not enter a label. 
ü Click the Recode button.  
 
 

 
 
A new column will be added to the spreadsheet that has the assigned variable name and the 
recoded values. The values and value labels will be added to the data file.  The data file must 
be saved to retain the new variable. 
 
 
Compute Variables 
 
Create a new variable by mathematically manipulating the values of the original variable.  This 
is most useful when transforming a variable such as by squaring (^2) or taking the square root 
(^.5) of the original values.  It is also useful for applying a constant to all observations in a 
variable to remove negative numbers or to develop an index.  The Compute procedure can be 
used to create an exact duplicate of a variable, the natural log of a variable’s values, a mean 
centered variable, or a variable converted to standardized (Z) scores. 
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Procedure 
 
ü Select the variable to use for the compute from the list box.  
ü Enter a variable name for the new variable (limit to 8 characters).  Example "AGESQ" for 

squaring age in years.  
ü Select the operation to perform by clicking on a radio button.  
ü Enter the value to use in the compute statement. Note that ^2 = square and ^.5 = square 

root.  
ü Click the Compute button.  
 
 
A new column will be added to the spreadsheet with the variable name and the computed 
values for all observations.  Select and compute multiple variables by holding the Control 
button [Mac Command button] while selecting variables in the list box.  Leave the variable 
name blank.  AcaStat will automatically name each new variable using the original variable 
name and adding “-2” to the name. 
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Combine Variables 
 
Use Combine Variables to create a third variable that is a mathematical combination of two 
other variables.  This feature creates a new variable that contains the result of the computation.  
Repeat the operation to systematically combine several variables into one. 
 
 

 
 
 
Procedure  
 
ü Select the first variable to use from the list box and click the Var1 button.  
ü Select the second variable from the list box and click the Var2 button. 
ü Enter a variable name for the new variable (limit to 8 characters).  
ü Select the operation to perform by clicking a radio button.  
ü Click the Combine button.  
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Find and Replace 
 
Use Find and Replace to change cell contents within one or more variables.  This feature is 
most useful for correcting data entry errors or removing unusual strings such as dollar notation 
($).  The Undo button will return the cell contents to the immediate proceeding value.  It is 
recommended that you conduct find and replace operations on a duplicate variable so you do 
not disturb the original variable. Use the Compute procedure to duplicate a variable. 
 
This procedure can be used on one or multiple variables by holding the Control button [Mac 
Command button] while selecting variables. 
 
If you wish to delete the value or string in the Find box, leave the Replace box empty.  Also 
note that this module will first search for an exact match of the entire cell contents and replace 
those contents when found.  If there is not an exact match, the module will then look for a 
match embedded within the cell contents. 
 
 

 
 
Procedure 
 
ü Select the variable to search by clicking on the variable name in the list box  
ü Enter the value or string of the search parameter  
ü Enter the value to use to replace the search parameter.  Leave blank if you want to delete 

the value or string (example above deletes $ from data entry). 
ü Click the "Replace" button 
 
Note:  It may be helpful to create and use a duplicate variable before conducting replace 
operations so the original variable is not disturbed.  Use the Compute procedure to duplicate a 
variable.  After ensuring the computed variable is accurate, the original variable may be deleted 
by selecting the variable in the data spreadsheet and deleting that column. 
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Trim Strings 
 
Use Trim Strings to create a variable that contains a truncated version of the original values.  
As an example, banking data may present activity with common leading text such as “Deposit” 
or “Transfer” that is followed by unique date or transaction numbers.  These unique text entries 
prevent aggregation of common transactions.  An example is displayed below. 
 

 
 
For aggregating EPayment entries in the Description variable, trimming the eight left most 
characters will condense data into common values so aggregate measures of payments can 
be calculated. 
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Procedure 
 
ü Select the variable trim by clicking on the variable name in the list box  
ü Select the location of the trimming as either starting from the left, starting from the far right 

or a range in between.  
ü Enter the number of characters to include in the trimming operation  
ü Click the "Trim" button 
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Calculate Menu  
 
 
Run Procedure 
 
Select Run Procedure to start an analysis.  This has the same function as the Calculate button 
on the toolbar. 
 
Run Chart 
 
Select Run Chart to create a chart.  This has the same function as the Calculate button on the 
toolbar. 
 
 
Data Examples Menu  
 
Use the example files to view variable and value formatting 
and to practice using statistical procedures and the Output 
Log.  The Student Workbook data file is a good practice 
file for experimenting with the statistical procedures and 
becoming comfortable with the Explore, Data, and Output 
Log tabs.  Use the Diagnostic Tests data file to try the 
Diagnostic Accuracy procedure.  Use the Appraisal Ratios 
data file to try the Appraisal module.  Additional data files 
and codebooks are available at http://www.acastat.com/data/data.html. 
 
 
Documentation Menu  
 
AcaStat includes links via an Internet connection to a 
QuickStart guide, an annotated Overview, User Manual, 
Student Workbook, and How To Guide in pdf format.  To 
read these files, Adobe Acrobat Reader must be installed on 
the host computer. Acrobat Reader is a free download from 
Adobe.  For more information, visit http://www.adobe.com.   
 
The documentation is also available at http://www.acastat.com/support/support.html. 
 
 
QuickStart 
 
This is a one-page overview of AcaStat that will help orient first time users. 
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Overview 
 
Provides an annotated overview of the four AcaStat tabs. 
 
 
How To Guide 
 
This provides a pdf version of the complete How To Guide that is available in the Help module.  
 
 
Stat Guide 
 
Provides annotated output examples for most statistical procedures.  Also available in the Help 
module. 
 
 
Student Workbook 
 
The Student Workbook contains over 20 lessons designed to introduce basic statistical 
concepts while also demonstrating the functionality of AcaStat.  The Appendix includes 
instructions for using SPSS. 
 
 
Free Applied Statistics iBook 

The Applied Statistics iBook contains formulas, definitions, and examples along with annotated 
output from statistical software.  It is designed to be a quick reference resource (not a 
complete statistics text).  The iBook is available from Apple or as a pdf from 
http://acastat.com/statbook/statbook.html. 
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Statistical Procedures Control Panel 
 
 
The Statistical Procedures control panel is used to select the type of analysis and variables.  
When the Options Panel is visible, an options box is displayed for each procedure and analysis 
list boxes are visible. 
 
 

Variable List  
 
Use the Variable List to select the variables for 
analysis.  As an example, to produce frequencies 
tables for the variables sex and race, select the sex 
variable in the variable list box.  A [+] indicator will 
appear in the Analyze header.  To add the selected 
variable to the Analysis Variables list box, click the list 
box header or drag the variable to the Analyze list 
box.  Use the same procedure to select and place the 
race variable in the list box.  Clicking the Calculate 
toolbar button will produce frequencies for both 
variables.  Output from the analyses will be displayed 
automatically and added to the Output Log.  
 
 
Dependent Variable  
 
The topmost variable list box is used for all univariate 
analyses (Frequencies and Descriptives) and one 
bivariate analysis (Correlation).  At least one analysis 
or dependent variable must be placed into the 
Analyze list box.  
 
 
Independent Variable  
 
With the exception of Frequencies, Descriptives, and Correlation procedures, an independent 
variable must also be selected (another list box will appear below the Analyze list box).  In the 
case of t-tests, subgroup values may be set in the options box for the independent variable so 
AcaStat compares the correct groups; or, when left blank, a t-test comparison is conducted on 
all possible group comparisons. 
 
 
Control Variable  
 
A control can be established for all procedures.  This limits the analysis to a specific subgroup. 
As an example, to correlate income with education for females only, locate the Sex variable 
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name from the variable list box and drag it into the control box, click the "=" button and 
indicate the value used for females.  This would result in a correlation procedure that excludes 
all males.  Generally, the control is a value (number) not a string (character).  If using a string 
control, only use the “=” control operator.   
 
 
Variable Selection Indicators  
 
AcaStat uses three color indicators to identify selected 
variables and their placement in the listboxes.  Blue for 
the top analysis listbox, green for the second listbox, and 
red for the control variable. 
 
 
Tips for using the Control Box 
 
If the “All Categories” option is available and selected, 
AcaStat will product statistics for each category in the 
control variable.  Some procedures will not allow or 
display the “All Categories” option.  In this case, the 
specific control value must be set.  The All Categories 
feature is handy for categorical controls such as sex and 
race but is not recommend for continuous controls such 
as age, body weight, and income unless they are first 
recoded into fewer groups as categorical values. 
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Statistical Procedures 
 
 
Frequencies  
  
This produces a listing of all the values in a variable, the number of times the values occur in 
the variable, and the percent of cases represented by each value.  Frequencies can be 
produced on numerical and string data. 
 
Output Example 
 

Frequencies 
Variable: Sex      Respondent sex 
 
Value                       Count        Percent      Cumulative 
----------------------------------------------------------------- 
Male                           26          52.00           52.00 
Female                         24          48.00          100.00 
----------------------------------------------------------------- 
           Total               50 
           Missing              0 
           Value Count          2 

 
Data File Format 
 
Each column in the data file represents one variable.  Each row represents one 
observation. In this example, each row represents the sex of one person. 
 
Value Labels:  For variables where the data represent meaningful numerical 
values (such as age), there is no need for value labels.  For variables where the 
data represent a word or phrase (such as respondent sex), a label for the data 
values will make the output much easier to interpret.  In the above example, a 
value of 1 represents “Male” and a value 2 represents “Female.”  Use the data formatting 
procedure to establish these value labels before running your analysis.  The analysis will 
still run without value formatting. 
 
Analysis Setup 
 
Select the Frequencies procedure, drag the variable(s) into the 
Analyze list box, and click Calculate.  You can produce frequencies 
tables for one or multiple variables. 
 
Options:  Check the Chi-Square box to conduct a goodness of fit 
test.  Check the Pareto Chart box to produce a chart that rank orders 
the variable categories from highest count to lowest. 
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List Variables 
  
This produces a listing of observations for up to ten variables.  Observations are listed in the 
order they appear in the data file. 
 
 
Output Example 
 

List Variables 
 
------------------------------------------------------------------------------------- 
  Obs               Idnum                Age                Sex               Income 
00001                 101                 37                  2                26872 
00002                 102                 36                  1                44992 
00003                 103                 55                  1               116920 
00004                 104                 57                  1                31478 
00005                 105                 35                  1                52228 
00006                 106                 52                  2                24976 
00007                 107                 26                  1                25311 
00008                 108                 48                  2                28086 
00009                 109                 32                  2                22710 
00010                 110                 38                  2                43782 
------------------------------------------------------------------------------------- 

 
 
 
 
Data File Format 
 
Each column in the data file represents 
one variable.  In this example, each row 
represents the responses of one person 
to a survey.  
 
 
 
 
Analysis Setup 
 
Select the List Variables procedure, drag the variables into the 
Analyze list box, enter number of observations (rows of data shown) 
or leave blank, and click Calculate.  List Variables produce lists for 
one to ten variables.  If there are no observations entered, List 
Variables outputs all rows of data. 
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Descriptives 
 
Calculates measures of central tendency (mean, median) and variation (variance, standard 
deviation).  
 
 
Output Example 
 

Descriptive Statistics 
Variable: Income     Respondent individual income 
------------------------------------------------------------------------------- 
Count                         50          Pop Var                261366243.0036 
Sum                      1705929.0000     Sam Var                266700247.9629 
Mean                       34118.5800     Pop Std                    16166.8254 
Median                     29256.5000     Sam Std                    16330.9598 
Min                        18938.0000     Std Error                   2309.5465 
Max                       116920.0000     CV%                           47.8653 
Range                      97982.0000     95% CI (+/-)                4641.2073 
Skewness                       2.9242     t-test(mu=0)  |p<|             0.0001 
Kurtosis                      14.4827      
------------------------------------------------------------------------------- 
 
Missing Cases          0 

 
 
 
Data File Format 
 
The column in the data file holds all data for one variable (Income).  In this 
example, each row represents one person’s annual income in U.S. dollars.  Note 
there is no comma indicating thousands.  Including commas in data is not 
recommended unless it is used as a decimal placeholder in non-English 
computer configurations. 
 
 
 
Analysis Setup 
 
Select the Descriptives procedure, drag the variable(s) into the 
Analyze list box, and click Calculate.   
 
Options:  Save Z-scores creates another column (variable) that 
holds each observation’s standardized z-score based on the 
sample mean and standard deviation.  Check Bar Chart to create 
a horizontal bar chart.  Check Percentiles to include a percentile 
table in the output (5, 10, 25, 50, 75, 90, 95). 
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Explore Means 
 
Explore Means produces descriptive statistics (sum, count, mean, sample standard deviation, 
standard error, 95% confidence interval) for each subgroup in the selected categorical 
variable(s).  Explore Means requires continuous data for the analysis variable.  The categorical 
variable can be a numeric or string variable. 
 
 
Output Example 
 

Controlling for Manager = No 
Descriptive Statistics 
Variable: Income     Respondent individual income 
------------------------------------------------------------------------------- 
Count                         36          Pop Var                272941697.3789 
Sum                      1135649.0000     Sam Var                280740031.5897 
Mean                       31545.8056     Pop Std                    16520.9472 
Median                     26667.0000     Sam Std                    16755.2986 
Min                        18938.0000     Std Error                   2792.5498 
Max                       116920.0000     CV%                           53.1142 
Range                      97982.0000     95% CI (+/-)                5669.1774 
Skewness                       3.8866     t-test(mu=0)  |p<|             0.0001 
Kurtosis                      20.0142      
------------------------------------------------------------------------------- 
 
Missing Cases         14 

 
 
Data File Format 
 
The columns in the data file hold all data for the Manager variable and 
Income variable.  In this example, each row represents one person’s role 
at work (non-manager [1] or manager [2]) and annual income in U.S. 
dollars. 
 
 
Analysis Setup 
 
Select the Explore Means procedure and drag the variable(s) used to 
create means (Income) into the Continuous list box.  Drag the 
variable(s) with the controlling categories (Manager-Yes/No) into the 
Categorical list box.  Click Calculate to produce descriptive statistics 
for managers and non-managers. 
 
 

Options:  Click options to limit the output to 
fewer statistics.  This alters the output in the 
Explore tab and Output Log tab. 
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Crosstabulation 
 
This is a useful procedure for representing the association between two categorical variables in 
a contingency table.  Each cell in a contingency table represents a subgroup.  For each cell, 
the count, row percent, column percent, and total percent are reported (default).  This 
procedure also automatically produces a chi-square statistic.  Crosstabulations are easiest to 
interpret when the number of rows and columns in the contingency table are 5 or less.   
 
Output Example 
 

Crosstabulation: Manager (Rows)  by  Sex  (Columns) 
Column Variable Label: Respondent sex 
Row Variable Label: In Management Position? 
 
       Count | 
       Row % | 
       Col % | 
     Total % |Male     |Female   |    Total  
-------------------------------------------- 
No           |       21|       15|       36 
             |    58.33|    41.67| 
             |    84.00|    71.43|    78.26 
             |    45.65|    32.61| 
-------------------------------------------- 
Yes          |        4|        6|       10 
             |    40.00|    60.00| 
             |    16.00|    28.57|    21.74 
             |     8.70|    13.04| 
-------------------------------------------- 
             |       25|       21|       46 
       Total |    54.35|    45.65|   100.00 

 
 
Data File Format 
 
The columns in the data file hold all data for the Manager variable and Sex 
variable.   In this example, Each row represents one person’s role at work 
(non-manager [1] or manager [2]) and sex (male [1] or female [2]). 
 
 
Analysis Setup  
 
Select the Crosstabulation procedure and drag one variable (Manager) 
into the Row list box.  Drag a second variable (Sex) into the Column list 
box.  Click Calculate to produce a contingency table with row and 
column counts and percentages. 
 

 
Options:  In addition to the default crosstabulation 
(contingency table), common chi-square statistics 
and measures of association can be provided.  The 
Cell Options button provides the ability to limit the 
cell contents to one or more descriptive measures 
(count, row %, column %, total %).  This alters 
what is presented in the Output Log.   
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T-tests of means  
 
Compare the difference between two sample means.  The dependent variable must be a 
continuous variable to produce the means for analysis.  The independent variable must be a 
categorical variable (often it will be a dichotomous variable such as sex: 0=male, 1=female).  
 
 
Output Example 
 

Two-Sample Difference of Means 
 
Independent Variable: Sex     Respondent Sex 
Dependent Variable: Income     Respondent individual income 
 
Sample One: 1           Male 
Sample Two: 2         Female 
 
                               Sample 1                Sample 2 
                                   Male                  Female 
--------------------------------------------------------------------------- 
Sample Mean                  37446.2692              30513.5833 
Std Deviation                20603.0733               8983.8769 
Sample Size (n)                 26                      24 
 
                                F-ratio             DF                 p <  
--------------------------------------------------------------------------- 
Homogeneity of Variance          5.2770          (25, 23)           0.0001 
 
                            T-statistic              DF      p < (2-tailed) 
--------------------------------------------------------------------------- 
Equal Variance                   1.5196           48                0.1352 
Unequal Variance                 1.5624           35.55             0.1301 

 
 
Data File Format  
 
One column contains the data used to calculate means (Income).  A 
second column (Sex) contains the data used to divide the means into two 
groups for comparison. In this example, each row represents one person’s 
income and sex (female or male). 
 
 
Analysis Setup  
 
Select the T-test of Means procedure and drag the variable used to 
calculate means (Income) into the Continuous list box.  Drag the 
variable used to categorize the comparison groups (Sex) into the 
Categorical list box.  Enter the values that represent the two 
comparison categories in the Group A (1= male) and Group B boxes 
(2=female).  Click Calculate.  If the group values are left blank, a t-
test comparison is conducted on all possible group comparisons. 
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Paired t-test 
 
Evaluates the significance of the mean difference between matched pairs (e.g., a pre-post 
experimental study design). Select the variable(s) in the variable list box and drag one 
numerical variable to the Sample A list box and one paired numerical variable to the Sample B 
list box.  
 
 
Output Example 
 

Group A  PostQuiz        
Group B  PreQuiz         
 
                            Group A             Group B                 A-B 
Summary Statistics         PostQuiz             PreQuiz           Mean Diff 
--------------------------------------------------------------------------- 
Sample Mean                 57.6923             53.6923              4.0000 
Median                      55.0000             54.0000              5.0000 
Min                         41.0000             37.0000             -6.0000 
Max                         75.0000             71.0000             12.0000 
Std. Deviation              10.8042             11.7003              5.2281 
Std. Error                   2.9965              3.2451              1.4500 
95% Lower Limit             51.1634             46.6219              0.8407 
95% Upper Limit             64.2212             60.7627              7.1593 
--------------------------------------------------------------------------- 
 
 
Mean Diff (A-B)          Std. Error           t        DF        p < 
-------------------------------------------------------------------- 
4.0000                       1.4500      2.7586        12     0.0173 

 
Missing: 0 

 
 
Data File Format 
 
Two columns in the data file hold the continuous data needed for a paired 
t-test.  One column contains the scores for a sample of students taking a 
quiz before instruction (PreQuiz).  A second column (PostQuiz) contains 
paired data for the same students on their quiz scores after instruction.   
 
 
Analysis Setup  
 
 
Select the Paired T-Test procedure and drag one continuous variable 
used to calculate means (PostQuiz) into the Group A list box.  Drag the 
paired continuous variable (PreQuiz) into the Group list box.  Click 
Calculate.  Reversing group A and B produces the same results but the 
sign (direction) of the test statistic will change. 
 
Options:  Check the Desc. Stats box to include descriptive statistics with 
the output (shown above).  
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Wilcoxon Signed-Rank 
 
Wilcoxon Signed-Rank is a nonparametric version of the paired t-test used to compare two 
related (correlated) populations, as is the case in pre-post treatment studies. Wilcoxon does 
not require interval-level (continuous) data. Select the variable(s) in the variable list box and 
drag one variable to the Sample A list box and one paired variable to the Sample B list box.  
 
Output Example 
 

Wilcoxon Matched-Pairs Signed-Rank Test 
 
Group A  XA             Quiz Score Before Instruction 
Group B  XB             Quiz Score After Instruction 
 
                            Group A             Group B                 A-B 
Summary Statistics*              XA                  XB           Mean Diff 
--------------------------------------------------------------------------- 
Mean                        48.9375             56.6875             -7.7500 
Median                      52.0000             58.0000             -5.5000 
Min                         20.0000             22.0000            -40.0000 
Max                         78.0000             90.0000             14.0000 
Std. Deviation              18.0350             21.0862             13.8684 
Count (N)                        16                  16                  16 
--------------------------------------------------------------------------- 
* Listwise distribution statistics before removal of ties. 

 
Wilcoxon W      W Std. Dev.         z*           p <       Exact**          N 
----------------------------------------------------------------------------- 
19                   15.930     -2.103        0.0355        0.1796         14 
----------------------------------------------------------------------------- 
*  Converted Z shows direction of difference. Negative Z denotes Group A < B. 
** Binomial distribution (2-tailed). 

 
Ranks                      N            Sum 
------------------------------------------- 
Negative Ranks            10             86 
Positive Ranks             4             19 
Excluded (A-B=0)           2 
Missing Cases              0 
------------------------------------------- 

 
Data File Format  
 
In this example, one column contains ordinal quiz scores before instruction and 
one column contains quiz scores for the same students after instruction. 
 
Analysis Setup  
 
Select the Wilcoxon procedure and drag one variable (PreTest) into the 
Sample A list box and one variable (PostTest) into the Sample B list box.  
Click Calculate. 
 
Options:  Select the Descriptive Statistics box for additional group 
statistics (shown above).    
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Mann-Whitney U 
 
Mann-Whitney U is a nonparametric test that evaluates the significance of the difference 
between two distributions of ordinal samples.  This procedure is similar to the two-sample t-
test but it does not require the assumption of continuous data in the dependent variable. It 
requires numerical data in the ordinal list box. Select the variable(s) in the variable list box and 
drag the ordinal variable to the Ordinal list box and one categorical variable to the Categorical 
list box. Select multiple variables by holding the Control button [Command button on Macs] 
and clicking variables in the list box. 
 
 
Output Example 
 

Mann Whitney U 
----------------------------------------------------------------------------- 
 
Ordinal Variable:   Score        
Group Variable:     Group 
 
Group                             U       Rank Sum      Rank Mean     Count 
--------------------------------------------------------------------------- 
1                           27.0000       128.0000        12.8000        10 
2                           73.0000        82.0000         8.2000        10 
--------------------------------------------------------------------------- 
 
Mann-Whitney U              27.0000 
Z Statistic                 -1.7386 
Z Dist.  p < (2-tailed)      0.0821 
 

 
Data File Format  
 
Two columns in the data file hold the data needed for Mann-Whitney U.  
One column contains ordinal data used to compare distributions (Score).  
A second column (Group) contains the data used to divide the ordinal 
scores into two groups for comparison.   In this example, each row 
represents one person’s test score and their training group. 
 
 
Analysis Setup  
 
Select the Mann-Whitney U procedure and drag the variable used to 
calculate distributions (Score) into the Ordinal list box.  Drag the variable 
used to categorize the comparison groups (Group) into the Categorical 
list box.  Input the group values (1 and 2) into the group category boxes.  
Click Calculate. 
 
Options:  Leave the Group A and B boxes empty and the procedure will 
run comparisons between each possible pair of categories. 
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Analysis of Variance (ANOVA)  
 
Compare the difference between two or more sample means.  Like t-tests, the dependent 
variable must be a continuous variable to produce the means for analysis.  The independent 
variable must be a nominal level variable (e.g., race: 1=white, 2=black, 3=Asian, 4=Hispanic. or 
ordinal (e.g., political ideology: 1=conservative, 2= moderate, 3=liberal).  
 
 
Output Example 
 

Independent Variable Label: Education Level 
Dependent Variable Label: Respondent individual income 
 
Group Summary Statistics 
 
Group                        N           Mean         Std. Dev. 
--------------------------------------------------------------- 
<12 yrs                      7      23188.4286        4081.0739 
HS Grade                    21      30731.2381        8521.1830 
College                     22      40829.7273       21211.0346 
 
 
 
Analysis of Variance 
 
                       Sum of Squares      df       Mean Squares         F       p < 
------------------------------------------------------------------------------------- 
Between Groups         2068102210.293       2     1034051105.146     4.418    0.0174 
 Within Groups        11000209939.887      47      234047019.998 
         Total        13068312150.180      49 

 
 
 
Data File Format  
 
Two columns in the data file hold the data needed for ANOVA.  One 
column contains the data used to calculate means (Income).  A second 
column (EduCat) contains the data used to divide the means into three 
groups for comparison.   In this example, each row represents one 
person’s income and education level. 
 
 
Analysis Setup  
 
Select the ANOVA procedure and drag the variable used to calculate 
means (Income) into the Continuous list box.  Drag the variable used 
to categorize the comparison groups (EduCat) into the Categorical list 
box.  Click Calculate. 
 
Options:  Check the Desc. Stats box to include descriptive statistics 
with the ANOVA output.  Click the Post Hoc box to conduct a 
Bonferroni test between groups. 
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Kruskal-Wallis 
 
Kruskal-Wallis is a nonparametric test that evaluates the significance of differences between 
the distributions of two or more samples.  This procedure is similar to one-way ANOVA but it 
does not require the assumption of continuous data in the dependent variable. It requires 
numerical data in the ordinal list box. Select the variable(s) in the variable list box and drag the 
ordinal variable to the Ordinal list box and one categorical variable to the Categorical list box.  
 
 
Output Example 
 
 

Ordinal Variable:   Murder Rate   
Group Variable:     City Type     
 
 
Kruskal-Wallis Group Statistics 
 
Group                      Rank Sum      Rank Mean     Count 
------------------------------------------------------------ 
Industrial City            124.0000        15.5000         8 
Trade City                  86.5000        10.8125         8 
Political City              89.5000        11.1875         8 
------------------------------------------------------------ 
 
Kruskall Wallis H            2.1722 
Chi-Square Dist.   p <       0.3375        DF  2 

 
 
Data File Format  
 
Two columns in the data file hold the data needed for Kruskal-Wallis.  
One column contains the data used to calculate ordinal distributions 
(Murder Rate).  A second column (City Type) contains the data used to 
separate the three samples for comparison.   In this example, each row 
represents one city’s murder rate and the city type (Industrial, Trade, 
Political). 
 
 
Analysis Setup  
 
Select the Kruskal-Wallis procedure and drag the variable used to 
calculate ordinal distributions (MurderRate) into the Ordinal list box.  
Drag the variable used to categorize the comparison groups (CityType) 
into the Categorical list box.  Click Calculate. 
 
Options:  Check the Desc. Stats box to include descriptive statistics 
with the Kruskal-Wallis output.   
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Pearson Correlation 
 
Calculates the Pearson correlation coefficient to represent the association between two 
continuous variables.  There are two options: create matrix or a scatterplot.  The scatterplot 
option provides basic statistics and displays a visual representation of the association between 
two variables.  For multiple comparisons, a correlation matrix is often the best choice.  
 
 
Output Example 
 

Scatterplot Option 
------------------------------------------------------- 
 
Y variable - Income   Respondent individual income 
X variable - Edu    Years of education 
 
Income 
 
  116920.0|                            *  
          |                               
          |                               
          |                               
   67929.0|                               
          |                   *     *     
          |          *                 *  
          |          *     *  *  *        
          |    *     *     *  *  *        
   18938.0| *  *  *  *  *  *  *           
           ---------------|--------------| Edu  
           8.0          14.0          20.0 
 
------------------------------------------------------- 
Number of cases: 50 
Missing: 0 
Pearson Correlation Coefficient (r):  0.638  p < 0.0001 
Coefficient of Determination  (rsq):  0.407 

Matrix Option 
--------------------------------- 
 
Correlation: Pearson (R) 
Coefficients 
 
--------------------------------- 
    Coeff |  Correlation Matrix | 
    Cases |---------------------| 
      p < |      Edu |    Income| 
--------------------------------- 
      Edu |    1.000 |    0.638 | 
          |       50 |       50 | 
          |    1.000 |    0.000 | 
--------------------------------- 
    Income|    0.638 |    1.000 | 
          |       50 |       50 | 
          |    0.000 |    1.000 | 
--------------------------------- 
 
 
   2-tailed significance tests 
    '.' p-value not computed 

 
 
Data File Format  
 
Two columns in the data file hold the data needed for Correlation.  Each 
column should contain continuous data.  In this example, each row 
represents one person’s income and education level. 
 
 
Analysis Setup  
 
Select the Correlation procedure and drag the variable used to represent 
the Y axis into the Analyze list box (Income).  Drag one or more additional 
variables (Edu) into the Analyze list box to represent the X axis.  Click 
Calculate. 
 
Options:  Select the Matrix box to produce a correlation matrix in the 
Output Log.  
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Spearman rho 
 
Evaluates the linear association between two ordinal variables.  This procedure is similar to 
Pearson Correlation but it does not require the assumption of continuous data in both 
variables. It requires ordinal numerical data. Select the variable(s) in the variable list box and 
drag the ordinal variables to the Analyze list box. Select multiple variables by holding the 
Control button [Command button on Macs] and clicking variables in the list box. 
 
 
Output Example 
 

Y Variable:  PARTYID     POLITICAL PARTY AFFILIATION 
X Variable:  POLVIEWS    THINK OF SELF AS LIBERAL OR CONSERVATIVE 

 
Spearman's rho 
------------------------------------- 
 
Correlation Coefficient      0.8283 
Test Statistic               9.8077 
p <  (2-tailed)              0.0001 

 
Spearman's rho (correction for ties) 
------------------------------------- 
 
Number of Ties in Y = 39 
Number of Ties in X = 39 
 
Correlation Coefficient      0.8163 
Test Statistic               9.3752 
p <  (2-tailed)              0.0001 

 
 
Data File Format  
 
Two columns in the data file hold the data needed for Spearman rho.  Each 
column should contain ordinal data.  In this example, each row represents 
one person’s political party identification and political ideology level. 
 
 
 
Analysis Setup  
 
Select the Spearman rho procedure and drag at least two ordinal variables 
into the Analyze list box.  In this example, drag PartyID and Polyviews. 
Click Calculate. 
 
Options:  Select the Matrix box to compare multiple ordinal variables 
placed in the Analyze list box.  
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Point-Biserial Correlation 
 
Evaluates association between one continuous variable and one dichotomous variable.  This 
procedure provides results equivalent to Pearson Correlation but it includes additional options 
for descriptive statistics and a test for homogeneity of variance. It requires numerical data in 
the Continuous list box. Select the variable(s) in the variable list box and drag the continuous 
variable to the Continuous list box and one categorical dichotomous variable to the Categorical 
list box. 
 
 
Output Example 
 

Y Variable:  Edu         Years of education 
X Variable:  Sex         Respondent sex 
 
                                  Sex  
                                 --------------------------- 
Edu                      Total           Male         Female 
------------------------------------------------------------ 
Mean                   13.4000        13.8077        12.9583 
Median                 12.0000        12.5000        12.0000 
Std. Dev.               2.7105         2.9532         2.4043 
Sample Size                 50             26             24 
------------------------------------------------------------ 

 
Correlation Coefficient     -0.1581 
t Test Statistic            -1.1096 
p <  (2-tailed)              0.2727 

 
Brown-Forsythe Test of Equal Variance 
-------------------------------------- 
F-Ratio                      1.1926 
p <                          0.2803 
 
Equal Variance Assumption Not Rejected 

 
Data File Format  
 
Two columns in the data file hold the data needed for Point-Serial Correlation.  
One column contains continuous data and one column contains a 
dichotomous categorical variable.  In this example, each row represents a 
person’s education and sex. 
 
 
Analysis Setup  
 
Select the Point-Biserial procedure and drag the continuous variable into the 
Continuous list box (Educ) and the categorical variable (Sex) into the 
Categorical list box.  Click Calculate. 
 
Options:  Select the Descriptive Statistics box for additional group statistics.  
Select Equal Variance to test the assumption of equal variance.  
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OLS Regression  
 
Calculates simple regression (one independent variable) or multiple regression (two or more 
independent variables).  Ordinary least squares (OLS) regression requires a continuous 
dependent variable.  As an option, ordinary least squares regression will add new variables to 
the spreadsheet representing residuals or predicted values for each observation.  OLS also 
allows models with no constant (regression through the origin).  Summary statistics for the 
variables included in the model are automatically included in the output. 
 
Output Example 
 

---------------------------- Multiple OLS Regression ----------------------------- 
 
Explanatory Model 
Income = Constant + Edu  + Sex  + e 
 
Model Fit Statistics 
 
     Cases(n)          R        R Square         Adj Rsq         SE Est. 
---------------------------------------------------------------------------------- 
          50       0.648           0.420           0.395       12700.994 
 
ANOVA Statistics 
                      Sum of Sqs      df             Mean Sq          F       p <  
---------------------------------------------------------------------------------- 
  Regression      5486495752.141       2      2743247876.070     17.006    0.0000 
    Residual      7581816398.039      47       161315242.511 
       Total     13068312150.180      49 
 
Coefficients 
Variable             b Coeff.     std. error        BetaWgt          t        p < 
---------------------------------------------------------------------------------- 
    Constant     -14073.80616     9686.41799                    -1.453     0.1529 
        Edu        3731.25894      677.93199        0.61929      5.504     0.0000 
        Sex       -3763.50763     3641.07887       -0.11630     -1.034     0.3066 
 
Estimated Model 
 
Income = -14073.806 +   3731.259(Edu ) +  -3763.508(Sex ) 

 
Data File Format  
 
Each variable used in the regression model has a separate column in the 
data file.  One column contains the dependent variable (Income) and two 
other columns represent the independent variables (Education and Sex).  
 
Analysis Setup  
 
Select the OLS Regression procedure and drag the variable used for 
the dependent variable in the Dependent list box. Drag the independent 
variables (Education and Sex) into the Independent list box.  Click 
Calculate. 
 
Options:  Click the Save Resids box to save the residual for each 
observation as a new variable.  Click the Save Pred. Y box to save the 
predicted dependent values for each observation as a new variable.  
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Logistic Regression  
 
Logistic regression requires a dichotomous (two values) dependent variable.  The two values in 
the dependent variable must be “0” and “1”.  Logistic regression will automatically produce 
summary statistics and, as an option, will add a new variable to the spreadsheet representing 
the predicted values for each observation. 
 
Output Example 
 

----------------------------- Logistic Regression ------------------------------- 
 
Explanatory Model 
Voted = Constant + EDUC + MARRIED + AGE + FEMALE + e 

 
Model Fit Statistics 
 
Initial -2 Log Likelihood   1736.53315 
Model -2 Log Likelihood     1533.11621    Iteration (4) 
Cox + Snell Rsq                0.13131 
McFadden Rsq                   0.11714 
Model Chi-Square             203.41694    df 4    p< 0.0000 

 
Coefficients 
Variable            b Coeff.         SE         Wald         p <        OR         
--------------------------------------------------------------------------- 
    Constant      -4.245174    0.405559   109.567839    0.000000 
        EDUC       0.277406    0.024716   125.970588    0.000000   1.319702 
     MARRIED       0.423702    0.124429    11.595131    0.000661   1.527607 
         AGE       0.032957    0.004037    66.638516    0.000000   1.033506 
      FEMALE      -0.088706    0.126167     0.494328    0.482003   0.915115 
--------------------------------------------------------------------------- 

 
Estimated Model 
Voted =   -4.245174 +   0.277406(EDUC) +   0.423702(MARRIED) +   0.032957(AGE) 
                    +   -0.088706(FEMALE) 

 
Data File Format  
 
Each variable used in the regression model has a separate 
column in the data file.  One column contains the 
dependent variable (Voted) and four other columns 
represent the independent variables (Education, Married, 
Age, and Female).  
 
Analysis Setup  
 
Select the Logistic Regression procedure and drag the variable used 
for the dependent variable in the Dependent list box (Voted 0=No, 
1=Yes). Drag the independent variables (Educ, Married, Age, Female) 
into the Independent list box.  Click Calculate. 
 
Options:  Click the Save Pred. Y box to save the predicted dependent 
values for each observation as a new variable.  
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Diagnostic Accuracy  
 
Diagnostic accuracy compares a test result to a dichotomous reference standard.  It is used to 
evaluate the sensitivity and specificity of a diagnostic test.  The reference variable can only be 
two values (usually 0 for non-disease and 1 for disease).  This represents the gold standard to 
compare to the test results.   
 
Each cell in the table holds counts.  The test variable can be nominal, ordinal, or interval/ratio. 
The lowest value for the reference standard must always represent non-disease.  The cutpoint 
(T+ >) represents the point beyond which the test is positive (disease indicated).  
 
As an example, if the expected test results range from 1 to 4, a cutpoint of 1 means a negative 
test result and a positive test is indicated by a value of 2, 3, or 4.  A practice data file 
“Diagnostic Tests” is included with AcaStat.  The data represent the use of Power Doppler 
imaging to estimate the level of a patient’s carotid stenosis (blockage of the carotid artery).  
 
 
Output Example 
 

Diagnostic Accuracy: Test (Test)  by  Gold (Reference) 
 
Reference Variable Label: Reference Standard 
Test Variable Label: Test - carotid stenosis 
 
                     [D-]         [D+]   
 
               | Not Diseased |     Diseased |        Total 
------------------------------------------------------------ 
         1-39% |           24 |            2 |           26 
------------------------------------------------------------ 
        40-59% |           17 |            9 |           26 
------------------------------------------------------------ 
        60-79% |            5 |           18 |           23 
------------------------------------------------------------ 
          80%+ |            4 |           21 |           25 
------------------------------------------------------------ 
         Total |           50 |           50 |          100 

 
 
Cut Point (T+ >)         Sn      Sp     PPV     NPV     LR+     LR-   Kappa     K p< 
------------------------------------------------------------------------------------ 
1-39%                 0.960   0.480   0.649   0.923   1.846   0.083   0.440   0.0001 
40-59%                0.780   0.820   0.812   0.788   4.333   0.268   0.600   0.0001 
60-79%                0.420   0.920   0.840   0.613   5.250   0.630   0.340   0.0007 
 
Area Under ROC Curve: 0.843 

 
 
Data File Format  
 
Data for the test results and known disease state (Gold Standard) are 
entered in separate columns.  The column containing the test result 
should contain values 1 through 4 (or greater) with an increasing value 
indicating a greater suspicion of disease.   The Gold Standard column 
must only contain two values (0=not diseased, 1=diseased).  Each row 
represents one patient with the known disease diagnosis and test result. 
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Analysis Setup  
 
Select the Diagnostic Test procedure and drag the variable with the 
test results into the Test Var list box. Drag the variable containing 
the gold standard results into the Gold Std list box.  Click 
Calculate. 
 
Options:  Click the Definitions box to include definitions of the 
diagnostic accuracy statistics with the output. 
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Random Sample  
 
This procedure is used to create a data file that is a randomly 
selected subset of the current spreadsheet.  Enter the sample 
size desired.  The sample size must be less than the total 
number of observations in the current data file. Click the Run 
button to replace the current data with a random sample. 
 
 
Data File Format  
 
This is an example of the first ten 
observations in a data file before random 
sampling.  Note the Idnum variable is in 
increments of one.   
 
 
Analysis Setup  
 
Select the Random Sample procedure and enter the sample size you 
wish to randomly select.  Click Calculate. 
 
 
 
 
 
 
 
 
 
 
 
Resulting Data File  
 
The resulting data file will show the randomly 
selected observations.  This file must be 
saved or it will be lost when AcaStat is 
closed.  
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Repeated Sampling  
 
The Repeated Sampling procedure conducts multiple 
random samples on one continuous variable to build a 
data set that reflects summary measures of that variable 
for each random sample.  This procedure helps students 
test the Central Limit Theorem: 
 
 

Central Limit Theorem 
 
As sample size increases, the sampling distribution 
of means approximates a normal distribution and is 
close to normal at a sample size of 30. 

 
 
This procedure creates repeated random samples for 
one continuous variable in the current spreadsheet.  For 
each sample (iteration), the mean and standard deviation 
are computed and placed into the spreadsheet.  This results in a new data file where each row 
represents the summary statistics for one random sample.   
 
 
Output Example 
 

 ----------------------------------------------------- 
| Results of Random Sampling                          | 
|                                                     | 
| Variable Randomized:         INCOME                 | 
| Size of Each Sample:             30                 | 
| Number of Random Samples:      1000                 | 
|                                                     | 
| This is the mean of means produced from repeated    | 
| random samples. The horizontal bar chart represents | 
| the distribution of means. Click the Data tab to    | 
| view the data for each sample.                      | 
 ----------------------------------------------------- 

 
                       Horizontal Bar Chart 
--------------------------------------------------------------------------- 
 
                  Bar Interval    Count 
        ----------------------   ------ 
          13585.23 to 18082.86       25  XX 
          18082.87 to 22580.49      101  XXXXXXXXXXX 
          22580.50 to 27078.11      198  XXXXXXXXXXXXXXXXXXXXXX 
          27078.12 to 31575.74      262  XXXXXXXXXXXXXXXXXXXXXXXXXXXXXX 
          31575.75 to 36073.36      217  XXXXXXXXXXXXXXXXXXXXXXXX 
          36073.37 to 40570.99      123  XXXXXXXXXXXXXX 
          40571.00 to 45068.61       50  XXXXX 
          45068.62 to 49566.24       19  XX 
          49566.24 to 54063.87        5  | 
 
--------------------------------------------------------------------------- 
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Data File Format  
 
The example to the right presents the first ten 
observations in a data file with 1,974 observations.   
 
 
 
 
Analysis Setup  
 
Select the Repeated Sample procedure.  Drag one continuous 
variable into the Sample Variable list box.  Enter the sample size 
(30) to be repeatedly randomly selected from the 1,974 
observations.  Enter the number of iterations for collecting 
repeated random samples of 30 observations.  Click Calculate.   
 
The sample size must be less than the total number of 
observations in the current data.  When the sampling is complete, 
AcaStat will run the Descriptives procedure on the mean variable. 
 
 
A Note About Missing Data 
 
If there is missing data in the continuous variable selected for 
random sampling, the procedure will remove those cases from repeated random sampling.  
 
To view an example, the AFQT data provided in the pull-down menu has a variable for parent 
income that has no missing values.  
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Appraisal Ratios Procedure 
 
The Appraisal Ratios procedure is used to evaluate tax assessment values of real estate.  Use 
of this procedure requires data on the market (selling) price and the assessed value of homes 
to compute ratios and other statistics.  A practice data file “Appraisal Ratios” is included with 
AcaStat. 
 
 
Output Example 
 

Appraisal Ratio Statistics 
 
Appraised Value:  Appraisal 
Market Price:     Price 
----------------------------------------------------------------- 
Number of Observations                                 36 
Total Appraised Value                          $3,627,040 
Total Sale Price                               $3,964,620 
Average Appraised Value                          $100,751 
Average Sale Price                               $110,128 
Mean Ratio                                              0.900 
Median Ratio                                            0.864 
Weighted Mean Ratio                                     0.915 
Price-Related Differential (PRD)                        0.983 
Coefficient of Dispersion (COD)                        29.82% 
Coefficient of Variation (CV)                          32.97% 
Minimum Ratio                                           0.348 
Maximum Ratio                                           1.363 
Ratio Range                                             1.016 
----------------------------------------------------------------- 

 
 
Data File Format  
 
Data for the appraised values of homes and their selling price are entered 
in separate columns.    
 
 
 
 
Analysis Setup  
 
Select the Appraisal Ratio procedure.  Drag the variable containing 
the appraised value of each home (Appraisal) into the Appraisal Value 
list box.  Drag the variable containing the selling price (Price) into the 
Market Value list box.  Each row represents data for one home.  Click 
Calculate. 
 
 
Options:  Click Save Ratios to save the appraisal ratio statistic for 
each home as a new variable. 
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Charts Module 
 
 
When in the Explore tab, click the chart toolbar icon to open or close the Charts module.  The 
Charts module produces graphic displays of data.  The chart can be saved, printed, and 
copied by using the toolbar buttons or menu pull-down.  The chart can also be formatted to 
adjust background and titles.  A control variable can be used to chart subgroups of data.   
 

 
 

Save Chart 
 
If using Windows and the system does not have QuickTime installed, the chart is saved as a 
".bmp" file.  Enter a file name and add the extension “.bmp” to ensure the file is saved as an 
image file.  For Mac systems and Windows with QuickTime, other file type options are available 
such as gif, png, and jpg. 
 
 
Paste Chart 
 
If using Windows, use Paste Special/Bitmap to paste the chart into other software such as 
Microsoft Word.  Mac users will only need to use Paste to insert the chart into a document. 
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Variable Limits 
 
Some charts only use one variable (e.g., pie, donut, histogram charts), while others use two 
variables.   
 
 

Editing Charts   
 
Most features of the charts are automatic based on the data and the labeling of variables and 
values in the data file.  However, some settings can be changed by clicking the Edit Chart button 
to view chart options.  Options include changing the chart title, axis labels, and the chart 
background.  Decimal values and minimum and maximum values for the Y and X axis (currently 
only available for scatterplots) can also be changed.  Click OK to rebuild the chart using the new 
settings.  Click Cancel to close without making the changes.  The chart procedure will return to 
the default settings when a new chart is created. 
 
 
Using the “By” Variable List box 
 
To produce a chart with group comparisons, place the grouping variable in the “By” variable list 
box.  An example is shown below where happiness is analyzed by the sex of the respondent.  
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Print Preview   
 
To open Print Preview, click the Print Preview button or click on the chart.  Print Preview provides 
options to save, copy, and print the displayed chart.  Enlarge the chart image by manually 
resizing the form. This option is especially helpful for improving the display of charts where the 
X axis labels are crowded.  
 

 
 
The Data Points toolbar option adds or removes the display of chart data.  The Count toolbar 
option cycles the Y axis from count to percent.  The Scale toolbar option changes the maximum 
percentage value of the Y axis. 
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Output Log  
 
 
The Output Log tab displays the results of the analysis in a text window for editing, printing, 
and saving as a text file.  Each time a statistical procedure is run, the results are automatically 
sent to the output log.  Notes can be added to the output before printing or saving. 
 
The Output Log uses Courier font for Mac and Consolas for Windows.  Both are a fixed font 
that ensures proper alignment of the tables.  When copying output to a word processor, the 
default font may not convey to the word processor.  This will result in tables that are out of 
alignment.  To correct this, highlight the output in the word processor and change the font to 
Courier or Consolas.  The font size may also need to be reduced to ensure the output fits 
widthwise on one page. 
 

 
Right click on the output to change the font style.  Right click on the Output List for options to 
delete, convert to tab output for coping/pasting into a spreadsheet, or to print the contents of 
the Output Log. 
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File Menu  
 
 
New 
 
Click the "New" button to erase all output.   
 
 
Open Output File 
 
This feature will load output saved from AcaStat Software 
statistical software products (AcaStat and StatCalc). 
 
 
Save Output As 
 
This menu item saves output as a text file with the file extension ".txt”.  This file can be opened 
in any word processor or spreadsheet application. Save all output or selected items in the 
output log.  To select multiple items in the Mac version, press and hold the Command key 
while selecting items in the output log.  For the Windows version, use the Control key for the 
same function. 
 
 
Print Output 
 
This menu item prints all output or selected items in the output log.  To select multiple items in 
the Mac version, press and hold the Command key while selecting items in the output log.  For 
the Windows version, use the Control key for the same function.  By default, AcaStat prints a 
date and time header and a Notes section on each page printed.  
 
 

Edit Menu  
 
 
Cut 
 
Use this menu item to remove selected output text and save 
the text to the system clipboard. 
 
 
Copy 
 
Use this menu item to copy selected output text to the system clipboard. 
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Paste 
 
Use this menu item to paste text from the system clipboard into the output screen. 
 
 
Select All 
 
Selects all the text in the output screen. 
 
 
Change Font Style 
 
Use the menu item or right click on the output textbox to view options for changing the text 
font.  The display of fixed font options will depend on what is available on the operating 
system. 
 

 
 
Convert Output to Tab Delimited 
 
Use this option to convert output to improve copying and pasting tables into a spreadsheet.  
This option inserts tabs into the output so that pasted output aligns properly in the columns of 
a spreadsheet.   
 
Use the Edit menu item Convert Output to Tab Delimited to convert the text.  The operation will 
automatically select the converted text. Click the copy button and open a spreadsheet 
program, select a cell in the spreadsheet, and click the paste button in the spreadsheet.  
Check the results carefully to ensure the table is formatted and aligned properly. 
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SumStats Module 
 
 
The SumStats tab provides 31 procedures for analyzing counts, proportions, and means 
(summary statistics).  The output for each procedure is appended to the Output Log.  A 
historical record is stored for each procedure (up to 10 calculations) to allow review and 
comparison of prior calculations.  Some procedures will provide more statistics in the Output 
Log than are displayed in the SumStats tab.  Controls in the Status Bar allow moving through 
up to ten prior calculations to view changes in confidence intervals, significance tests, and 
other SumStats procedures without going to the Output Log.  Confidence interval and 
significance bar charts are displayed for relevant statistical procedures to provide a visual 
display of the results.  Click on the chart to view an options module for saving, copying, and 
printing. 
 

 
For procedures that provide selected checkboxes for each row of data, clicking the checkbox 
to off will exclude that row from the analysis.  The default condition is checked.  Any rows with 
the checkbox enabled that do not have data will be excluded automatically. 
 
 

  



 

AcaStat User Manual 69 

Statistical Procedures 
 
 
Weighted Mean 
 
Calculates the mean for a group of means. For each mean, enter the mean and its sample size. 
Click calculate when done.  The output includes the mean if the group of means had not been 
weighted by the sample size. This value is for comparison purposes only -- do not use the 
unweighted mean.  Data entry can be copied and pasted to and from spreadsheet or 
document software.  Groups can be excluded by deselecting a row checkbox. 
 
 
Z-Score 
 
Calculates the standardized score for a specific value in a distribution represented by a mean 
and standard deviation.   
 
 
Confidence Interval for the Mean 
 
Calculates the confidence interval for the population mean based on a sample mean, standard 
deviation, and given sample size.  The confidence level is adjustable from 80% to 99%.  
 
 
Confidence Interval for the Proportion 
 
Calculates the confidence interval for the population proportion based on a sample proportion 
and given sample size.  The confidence level is adjustable from 80% to 99%. 
 
 
Diagnostic Accuracy 
 
Diagnostic accuracy compares a test result to a dichotomous reference standard. It is used to 
evaluate the sensitivity and specificity of a diagnostic test. The reference and test variables can 
only be two values (usually 0 for non-disease and 1 for disease). The reference variable 
represents the gold standard to compare to the test results.   
 
 
Goodness of Fit 
 
Use this procedure to evaluate the variation in a distribution of categories. Each row in the 
table represents one category among several. For each category, enter the observed count 
and the expected count.  Generally, the expected count is established by estimating a priori 
the proportional distribution of the categories.  The expected frequency for each category can 
be obtained by multiplying the total observed sample size by the a priori (expected) proportion 
for each category.  StatCalc calculates the standardized residual for each category. A residual 
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of +/- 2.0 or greater suggests that category had a substantive impact on the chi-square test 
statistic.  Data entry can be copied and pasted to and from spreadsheet or document 
software.  Groups can be excluded by deselecting a row checkbox. 
 
 
Chi-Square 
 
This procedure presents the association between two categorical variables via a contingency 
table. Each cell in a contingency table represents a subgroup. All the rows and columns 
provided by StatCalc do not need to be used but always start with the top leftmost cell.  Enter 
counts in each cell and StatCalc will calculate for each cell the row percent, column percent, 
and total percent.  Chi-Square also automatically produces several contingency table statistics 
to include the chi-square statistic and measures of strength of association.  SumStats chi-
square allows for a contingency table with up to six rows and six columns. 
 
 
Z-test One Sample 
 
Used to test for the difference between one population proportion and one sample proportion. 
Enter the population proportion, sample proportion, and the number of observations in the 
sample.  
 
 
Z-test Two Sample 
 
Used to test for the difference between two sample proportions.  For two sample z-tests, both 
dependent and independent variables must be nominal level variables. 
 
 
T-test One Sample 
 
Used to test for the difference between one population mean (mu) and one sample mean. Enter 
the population mean, sample mean, sample (or population) standard deviation and the number 
of observations in the sample.  
 
 
T-test Two Sample 
 
Used to test for the difference between two sample means. For t-tests, the dependent variable 
must be an interval/ratio level variable to produce the means for analysis. The independent 
variable must be a nominal or ordinal level variable (often it will be a dichotomous variable such 
as sex: 1=male, 2=female).  
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One-Way ANOVA 
 
Used to test for the difference between two or more sample means.  The dependent variable 
must be an interval/ratio level variable to produce the means for analysis.  The independent 
variable must be a nominal level variable (e.g., race: 1=white, 2=black, 3=Asian, 4=Hispanic) or 
ordinal (e.g., political ideology: 1=conservative, 2= moderate, 3=liberal).  All the rows and 
columns provided do not have to be used but always start with the top leftmost cell.  StatCalc 
ANOVA allows for up to six categories of sample means. 
 
 
Z Distribution  
 
Enter a z score to calculate the proportion of the probability distribution at or beyond the score 
entered.  This procedure is most useful for evaluating the statistical significance of a z-test 
statistic calculated manually. 
 
 
T Distribution  
 
Enter a t score and degrees of freedom to calculate the proportion of the probability 
distribution at or beyond the score entered.  This procedure is most useful for evaluating the 
statistical significance of a t-test statistic calculated manually. 
 
 
F Distribution  
 
Enter a f ratio score and numerator and denominator degrees of freedom (consult a statistical 
reference) to calculate the proportion of the probability distribution at or above the score 
entered.  This procedure is most useful for evaluating the statistical significance of an f test 
statistic calculated manually. 
 
 
Chi Square Distribution  
 
Enter a chi-square score and degrees of freedom to calculate the proportion of the probability 
distribution at or above the score entered.  This procedure is most useful for evaluating the 
statistical significance of a chi-square test statistic calculated manually. 
 
 
Epi Curve  
 
Enter time and case data to create an Epidemic Curve.  The time column data must include 
consecutive dates even if there are no cases for that date.  Data entry can be copied and 
pasted into spreadsheet or document software for saving and later pasting back into the 
Epidemic Curve procedure.  
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Click on the chart to enter Chart Preview.  Click show data values to display counts in the chart 
columns.  Click on the main chart body and a pop-up color picker will be displayed to change 
the color of the data values displayed in the columns. 
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Epi Rates  
 

 
Select one of the options and enter the data as indicated. After 
entering data, click the Calculate button on the toolbar.  The results 
will be displayed in the SumStats module and appended to the 
Output Log for saving, coping, or printing. 
 
 
 
 
 

Epi Direct Standardization  
 
Enter group labels and population values from a standard population model.  Enter number of 
deaths and population for each group in the comparison population.  After entering data, click 
the Calculate button on the toolbar.  The results will be displayed in the SumStats module and 
appended to the Output Log for saving, coping, or printing.  Groups can be excluded by 
deselecting a row checkbox. 
 
Data can be copied/pasted to and from a spreadsheet.  Copied spreadsheet data must be 
consistent with the module table.  Each column should have a consistent variable name.  An 
example is provided below: 
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Epi Risk  
 
 
Select one of the options and enter the data as indicated. After 
entering data, click the Calculate button on the toolbar.  The results 
will be displayed in the SumStats module and appended to the 
Output Log for saving, coping, or printing. 
 
 
 
 
 

A 2x2 table is provided for the relative risk and odds ratio procedures.  The column and row 
labeling represent the following: 
 
D+  -  Disease present or in the case of mortality this represents death 
D-  -  Disease absent or in the case of mortality this represents no death 
Exposed -  Treated group or group exposed to external factor such as cigarette smoking 
Non-Exposed -  Untreated group or group not exposed to external factor  
 

 
 
Disaggregate Counts  
 
Enter category headings and count data from summary statistics to create a case level data file 
in the AcaStat Data tab for analysis and creating charts.  Data entry can be copied and pasted 
to and from spreadsheet or document software.   
 
To view how data needs to be formatted for pasting into SumStats, copy the example data and 
paste it into a spreadsheet.  The example data should appear similar to the following: 
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Decision Tools  
 
The Decision Tools tab provides four tools for calculating constant dollars and experimenting 
with decision tables, queuing theory (waiting lines), and price elasticity of demand.  An example 
is provided for each tool.  The results are displayed in SumStats and are added to the Output 
Log.  A good reference text for most of these tools is Fundamentals of Management Science, 
by Efraim Turban & Jack R. Meredith. 
 

 
 
Constant Dollars 
 
This tool uses the urban consumer price index (CPI-U) for the United States to adjust for 
inflation.  The module will create and apply an inflation and deflation estimate.  Another price 
index can be used by overriding the default CPI by clicking on and changing the CPI. 
 
 
Queuing Theory 
 
Queuing theory is used to evaluate the performance of service systems where waiting lines 
may form and customers arrive at random times (i.e., license bureau, tax assessors office, 
emergency room). To evaluate a waiting line, data must be provided for the average arrival 
rate, average service rate, and the number of servicers. 
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Price Elasticity of Demand 
 
This tool uses the change in demand that occurs when a price is changed to estimate price 
elasticity. Given the estimate of elasticity, the tool will attempt to find a breakeven price 
through iterations of price.  Both fixed and variable costs can be included in the model. 
 
 
Decision Tables 
 
Decision tables quantify in table form the impact of decision options under uncertainty.  Tables 
will typically contain the following elements: 
 
1. Alternative courses of action 
2. States of nature 
3. Probabilities of states of nature (must sum to 1)  
4. The payoffs  
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Tables Module 
 
 
Use the Tables tab to evaluate the relationships between multiple categorical variables with 
column percentages produced from the crosstabulation procedure. 
 

 
 
Data File Format 
 
Both continuous and categorical variables can be used to create tables but categorical 
variables are recommended.  The summary table performs best when categorical variables that 
are recorded as values in the data file have been formatted with value labels. 
 
 
Analysis Setup 
 
Drag at least one variable into the Row list box and one into the Column list box.  Click 
Calculate to produce the table.  The table is based on multiple crosstabulation procedures. The 
column percentages from each crosstabulation are displayed in the table. 
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Column Headers 
 
The counts and margin of error are based on the lowest sample size in the row variables. 
 
Controls 
 
Two controls can be used to filter the data used in the table. 
 
Options 
 
The expandable Options Panel allows changing numerical formats and adding a customized 
table title.  All table cells are editable before printing. 
 
Margin of Error 
 
The margin of error for each column variable is based on a 95% confidence level with a 
proportion = .50 (the most conservative estimate of error for proportions) and the column 
sample size. 
 
 
Limitations 
 

• Currently only available for reporting percentages. The Tables module is not designed 
to report means or variance. 

 
• Large variable or value names should be shortened to fit in the column widths provided. 

The Tables spreadsheet allows editing before printing or copying. 
 

• Printing works best with 13 or fewer columns for portrait and 15 or fewer columns for 
landscape. For additional column variables, create separate tables with fewer column 
variables when using the print function. 

 
• The Tables spreadsheet is limited to 25 columns (includes the first column of row labels 

and the Total column).  A full (25 column) Tables spreadsheet will not print properly, but 
it can be copied and pasted into spreadsheet software for saving and editing. 
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Other AcaStat Features 
 
 

Help Menu  
 
 
AcaStat Help 
 
Click Help to open the help module.  
The contents can be sorted or 
searched by topic. 
 
 
Application Overview 
 
Provides an annotated guide to basic features. 
 
 
Statistics Glossary 
 
The glossary contains over 250 terms and definitions.  The search button will find matching 
records and sort the list box so all topics matching the search are listed at the top in bold.  
Pressing the Enter key after entering a search term will also initiate the search.  Press Reset 
before conducting another search. 
 
 
How To Guide 
 
Provides examples for each statistical procedure. 
 
 
Stat Guide 
 
The Stat Guide provides annotated output examples for many of AcaStat’s statistical 
procedures. 
 
 
Help Dashboard 
 
This links to the AcaStat help page that contains all the application and statistical help 
documentation alone with a link to request support. 
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Check for Updates 
 
The Help menu contains an option to check for updates.  AcaStat connects to the Internet and 
automatically compares the installed version with the version of the update.  If a newer update 
is available, you will be given the option to download the installation file.  Once downloaded, 
exit AcaStat and double-click on the installation file to run the update. 
 
The update option is only available for licensed users.  It is not available for versions purchase 
from Mac App Store.  Updates for Mac App Store purchases are automatically pushed to 
licensed users. 
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System Requirements 
 
 
MacOS 
 
• At least 2GB of RAM 
• At least 35MB of disk space 
• macOS Catalina 10.15.x 
• macOS Mojave 10.14.x 
• macOS High Sierra 10.13.x 
• macOS Sierra 10.12.x 
• OS X El Capitan 10.11.x 

 
Windows 
 
• 32-bit and 64-bit versions are supported 
• At least 2GB of RAM 
• At least 55MB of disk space 
• Windows 10 
• Windows 8.1 
• Windows 7 SP1 
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AcaStat Software 
 

http://www.acastat.com 
 
 
 
 
 


